
EXPERIMENT 4                                                                                            
Determination of Acid Constant, Ka 

 
PURPOSE:  
The purpose of this experiment is to determine the Ka of an acid from its molar concentration and 
from its titration curve. 
 
INTRODUCTION:  
When an acid is dissolved in water, it reacts with the water according to the equation: 
 
 HA(aq)  +  H2O(1)   H3O+(aq)  +  A-(aq)    (1) 

 
The reaction is reversible and so establishes an equilibrium with a constant, Ka, based on the 
relationship: 
 
 Ka = [H3O+] [A-]     (2)   
                                 [HA] 
 
From this the familiar Henderson-Hasselbalch Equation is derived: 
 
 pH = pKa + log [A-]     (3) 
                                     [HA] 
  
During the course of a titration, an acid in solution reacts with a base in solution. 
 
 HA(aq) + OH- (aq) → A- (aq) + H2O (1)    (4) 
 
At the equivalence point the titration is complete, no HA remains; all is in the form of the 
conjugate base, A-, and water. Halfway to the end point, half of the HA has reacted to become its 
conjugate base A- and water. At that point, the concentrations of HA and A- are equal. When 
these concentrations are equal, log [A-]/[HA] is zero and pH = pKa (Equations 3). It is clear then 
that pKa can be read directly from the titration curve as the pH at the half-way point of a titration. 
 
There are several parts to this experiment. The general plan is to: 

1. Prepare and standardize a base solution for titrating the acid solution, 
2. Determine the molarity and pH of the acid solution with the standardized NaOH and use 

the equilibrium expression to calculate Ka, 
3. Titrate the acid with the base to develop the titration curve, and interpret the curve to 

determine the molarity of the acid solution and the Ka of the acid. 
4. Perform a half-titration of acetic acid with sodium hydroxide to determine the Ka. 

 
Part I:  Preparation and Standardization of the NaOH Solution 
 
It will be necessary to prepare 500 mL of an approximately 0.1 M NaOH by diluting a the 
appropriate amount of 6.0 M NaOH(aq) to about 500 mL. 
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Shelf reagents are not prepared to any high degree of accuracy, and even if they were, could not 
be kept long at a particular concentration due to gradual changes from exposure. If a solution is 
prepared from a shelf reagent by dilution, no matter how carefully measurements are made, the 
result will be a solution of undetermined concentration. It must be standardized to know its 
concentration beyond two significant figures. 
 
Potassium hydrogen phthalate, (KHC8H4O4), abbreviated KHP, is a monoprotic weak acid that is 
commonly used as the primary standard.  It reacts with sodium hydroxide according to 
 
 KHC8H4O4(aq)  +  NaOH(aq)  H2O(l)  +  Na KC8H4O4(aq)  (5) 
 
Titration with of a known mass of KHP to the endpoint with a carefully measured volume of 
NaOH is performed.  Equation (5) allows one to determine the number of moles of NaOH 
needed to reach the endpoint.  Given the volume of NaOH dispensed to reach the endpoint one 
can then calculate the molarity of the NaOH. 
 
1.  Measure out about 0.5 gram of KHP on an analytical balance and record the weight to four 
significant figures.  Use the weighing bottle technique to measure out the KHP by first weighing 
a shell vial of KHP, dispensing some KHP into a dry 125 mL Erlenmeyer flask and then 
reweighing the vial of KHP.  Repeat this process until the mass of KHP in the vial is reduced by 
about 0.5 g.  When this is the case this means you have transferred about 0.5 g of KHP to your 
Erlenmeyer flask.   
 
2.  Dissolve the KHP in approximately 50mL of deionized water. Add 2-3 drops of 
phenolphthalein indicator and titrate the KHP solution with the NaOH solution from a buret to a 
light pink color. Determine very precisely the volume of base required to reach the endpoint by 
approximating between the marks on the burette for a fourth significant figure.  
 
3.  Repeat the titrations until you have three reliable trials.  A proper standardization requires a 
minimum of three trials that agree within plus or minus 0.5% of each other. A quick check of the 
reproducibility of your titrations is to calculate the ratio of g KHP/mL NaOH to four significant 
figures.  This ratio should vary only in the last significant figure.  Repeat the standardization 
process until three trials do agree within these limits. Calculate the molar concentration of the 
base from the data from each trial and then calculate the average concentration. 
 
 
Part II:  Determine the Molarity and pH of the Acetic Acid Solution  
 
Acetic acid is a monoprotic weak acid and will be neutralized by sodium hydroxide according to  
 
CH3COOH(aq)  +  NaOH(aq) → H2O(l)  +  NaCH3COO(aq)   (6) 
 
You will use your standardized sodium hydroxide to determine the molarity of the acetic acid 
solution. 
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1. Obtain about 150 mL of the acetic acid solution of unknown molarity from your 
instructor.  Transfer a small portion of the acetic acid unknown to a small (10 mL or 30 
mL) beaker.  
 

2. Perform a two-point calibration of your pH meter with pH 4 and pH 7 buffer.  Once the 
pH meter is calibrated, measure the pH of your acetic acid solution and determine the 
[H3O+]. 

 
3. Use a volumetric pipette to transfer a 25.00-mL sample of the acetic acid solution to a 

125-mL Erlenmeyer flask.  Add 2-3 drops of phenolphthalein indicator to the sample. 
 
4. Fill your buret with your standardized sodium hydroxide solution and titrate to the 

endpoint.  Repeat until you obtain three reproducible trials.  Report the average molarity 
of the acetic acid solution to four significant figures.  Use this molarity and the pH from 
step 1 to calculate Ka from equation (2) above. 

 
 
Part III:  Develop a Titration Curve to Determine the Molarity and Ka 
 

A.  Data Collection 

NOTE:  This will be performed in place of the manual procedure for developing a titration 
curve using a buret.  The Vernier LabQuest with pH probe and drop counter will be 
used, see Figure 1.  Collect from the Stockroom: 1-pH sensor for the Venier, 1-drop 
counter for the vernier, Vernier LabQuest computer, & a stir bar. 

 

   Fig. 1 – the dropper counter 
   LabQuest set-up. The plastic 
   reservoir, pH probe , and drop 
   counter are all attached to a ring 
   stand. 
 

 

 

1.   Connect the pH sensor to Channel 1 on the LabQuest. Mount the drop counter on a ring stand 
and connect it to DIG 1 on the side of the LabQuest. Choose New from the File menu. 

2.  Perform a two-point calibration of the pH electrode with pH = 4 and pH = 7 buffers.  To 
calibrate the pH sensor: Either tap on SENSORS menu at the top of the screen choose 
CALIBRATE then CH1: pH or tap on the numerical value associated with pH on the center 
screen and a pop-up for CALIBRATE will appear.  The next screen should exhibit a tab 
labeled CALIBRATE NOW located top left of the screen, place the sensor in the buffer 7 
solution, allow the numerical values on the top right to stabilize then press KEEP.  Clean the 
electrode in deionized water and place the electrode in the buffer 4.  Once again stabilize and 
press KEEP.  The pH sensor is now calibrated.   
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3. Set up the reservoir, equilibrate it and fill it with your standardized NaOH(aq) solution.  
Flush out any air bubbles in the reservoir tip by draining the NaOH(aq) solution into a waste 
beaker. 

4.   IMPORTANT:  Align the tip of the reservoir such that it is centered in both directions above 
the drop counter slot. 

5. Calibrate the drop counter so a precise volume of titrant is recorded in units of milliliters. 
a. Choose Calibrate from the sensors menu and select drop counter. 

• If this is your first trial with the current reservoir, then you need to perform a new 
calibration.  Select Start and continue on to (b) below. 

• If you previously calibrated the drop size of this reservoir in a previous trial and want 
to continue with the same drop size, select Equation. Enter the value for the 
drops/mL and select Apply. Select OK and proceed directly to Step 5. 

b. Place an empty 10-mL graduated cylinder directly below the slot on the drop counter, 
lining it up with the tip of the reagent reservoir.  Open the bottom valve on the reservoir 
while keeping the top valve closed. 

c. Click the Start button.  Slowly open the top valve of the reservoir such that drops are such 
that drops are released at a slow rate (~1 drop every two seconds). You should see the 
drops being counted on the screen. 

d. When the volume of NaOH solution dispensed is between 9 and 10 mL, close the 
stopcock. 

e. Enter the precise volume of NaOH to the nearest 0.1 mL and select Stop. Record the 
number of drops/mL displayed on the screen for possible future use. Select OK.  Your 
drop size has been calibrated and the drop counter will now be able to record the correct 
volume of NaOH added during your titration. 

 
6. Refill your reservoir with the NaOH solution.  With a volumetric pipet transfer 25.00 mL of 

your acetic acid solution to a 400-mL beaker.  Place a magnetic stir bar in your beaker 
containing your acetic acid solution and place the beaker on the magnetic stirrer on the base 
of the ring stand.  

7.   Insert the pH sensor through the large hole in the drop counter.   
 
8.   Adjust the positions of the drop counter and buret so they are both lined up near the center of 
the magnetic stirrer.  Lower the pH sensor/drop counter assembly into the beaker.  Make sure the 
height is adjusted such that the stir bar does not hit the bottom of the pH electrode.  Adjust the 
reagent reservoir so its tip is just above the drop counter slot.  If the level of solution is not high 
enough to cover the bottom of the pH sensor, add more deionized water to the beaker.  Turn on 
the magnetic stirrer so that the stir bar is stirring at a moderate rate. 
 
9. You are now ready to perform the titration. 

a. Tap Start to start data collection. No data will be collected until the first drop goes 
through the drop counter slot. 

b. Open the buret stopcock slowly until drops are released at a rate of about 1 drop every 1-2 
seconds. When the first drop passes through the drop counter slot, check the graph to see 
that the first data pair was recorded. 

c. Continue the titration until 50.00 mL of the sodium hydroxide has been dispensed. 
d. Close the stopcock and tap Stop to stop the data collection. 

 
10.   Save your data to your flash drive! 
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11. Dispose of the reaction mixture as directed. Rinse the pH sensor with deionized water in 
preparation for the second titration. 

 12. Repeat the titration with a second sample of acetic acid. To begin trial two, locate the icon on 
the right side of the box labeled “RUN 1”.  It looks like a picture of a filing cabinet.  Press 
the icon (filing cabinet) and the box will read “RUN2”.  You are ready to proceed, all with 
the same calibrations.  Analyze the titration results in a manner similar to your first trial and 
record the equivalence point in your notebook.  Use your determination of the equivalence 
point volume in to calculate the molar concentration of your acetic acid solution and 
determine the acid dissociation constant for acetic acid.  Print copies of your titration curves 
to include with your report. 

B.  Analysis of Titration Curves: 

 Examine your titration data to identify the region where the pH made the greatest increase. 
The equivalence point is in this region. 
a. To examine the data pairs on the displayed graph, select any data point. 
b. As you move the “examine” line, the pH and volume values of each data point are 

displayed to the right of the graph. 
c. Identify the equivalence point as precisely as possible and record this information in your 

notebook. 
d. Store the data from the first run by tapping the File Cabinet icon. 

  
  An alternate way of determining the precise equivalence point of the titration is to take the 

first and second derivatives of the pH-volume data: 

Determine the peak value on the first derivative vs. volume plot. 
a. Tap the Table tab and choose New Calculated Column from the Table menu. 
b. Enter d1 as the Calculated Column Name. Select the equation 1st Derivative (Y,X). Use 

Volume as the Column for X and pH as the Column for Y. Select OK. 
c. On the displayed plot of d1 vs. volume, examine the graph to determine the volume at the 

peak value of the first derivative. 
 

Determine the zero value on the second derivative vs. volume plot. 
d. Tap Table and choose New Calculated Column from the Table menu. 
e. Enter d2 as the Calculated Column Name. Select the equation 2nd Derivative (Y,X). Use 

Volume as the Column for X and pH as the Column for Y. Select OK. 
f. On the displayed plot of d2 vs. volume, examine the graph to determine the volume when 

the 2nd derivative equals approximately zero. 
 
Part IV:  Perform a Half-Titration to determine the Ka of Acetic Acid     

  In this procedure you first titrate 25.00 mL of 1.00 M acetic acid to the endpoint with 1.00 M 
sodium hydroxide.  You will then back-titrate with the acetic acid until the solution is just 
slightly acidic, i.e. to just before the endpoint.  You then carefully add just enough sodium 
hydroxide to reach the endpoint again.  This will be monitored concurrently with 
phenolphthalein indicator and the pH meter.  Once you have successfully determined the 
endpoint, you will then add another 25.00 mL of the 1.00 M acetic acid.  This will effectively 
create a half-titrated solution, and the pH will be the pH at the half-equivalence point.  This is 
the pKa of the acetic acid. 
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1. Use a 25-mL volumetric pipet to transfer precisely 25.00 mL of 1.00 acetic acid solution to a 
250 mL beaker.  Add 2 drops of phenolphthalein indicator. 

2. Connect the pH electrode to LabQuest and choose New from the File menu. Perform a two-
point calibration of the pH electrode with pH = 4 and pH = 7 buffers.  Follow the calibration 
instructions included with the electrode. 

3. Fill a 50-mL buret with 1.00 M NaOH solution. 

4. Begin the half-titration. 
a. Place the beaker of acetic acid on a magnetic stirrer and add a stirring bar. 
b. Set up a ring stand and clamp to hold the pH Sensor in place. Position the pH Sensor in 

the beaker so that the tip of the probe is completely immersed. 
c. Turn on the magnetic stirrer and adjust the stirring rate to give gentle stirring. 
d. Monitor the pH of the reaction mixture on LabQuest.  (Do not tap Start!) 
e. Use your buret to slowly add your NaOH solution, in ~1 mL increments, to the beaker of 

acetic acid solution. 
 
5. Conduct the titration carefully. As the reaction approaches the equivalence point, at about 

pH 6, add the NaOH solution drop by drop. Periodically rinse the sides of the beaker with 
deionized water.  When you reach the equivalence point, the pH will increase rapidly and the 
indicator will change color. If necessary add another drop of NaOH so that the reaction is 
slightly past the equivalence point. Remember that the pH will not increase rapidly beyond 
the equivalence point (pH ~10). 

 6. Now you will check the equivalence point.  First, carefully add acetic acid to the solution 
until the pH is just acidic.  Then, carefully add NaOH dropwise to the beaker of reaction 
mixture, until you reach the equivalence point as precisely as possible. A very slight pink 
color of the phenolphthalein indicator is visible. At this point you have effectively titrated 
25.00 mL of the 1.00 M acetic acid to the equivalence point. 

 7. Transfer another 25.00 mL of 1.00 M acetic acid from to the 250 mL beaker of reaction 
mixture. Continue to stir the solution in the beaker thoroughly. By adding the additional 
25.00 mL of acetic acid solution you have effectively titrated 50.00 mL total of 1.00 M acetic 
acid solution to the half-equivalence point.  Read and record the pH of the solution in the 
beaker. 

 8. When you have finished the testing, dispose of the reaction mixture as directed. Rinse the pH 
Sensor with distilled water in preparation for a second trial. If time permits, repeat the half-
titration with a second sample of the 1.00 M acetic acid solution. 
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REPORT GUIDELINES/INSTRUCTIONS 
 
Table 1 – Data and Calculation for Standardization 
On a separate sheet of paper prepare a table which presents your data for the standardization of 
the 0.1 M NaOH solution by titration of KHP.  Be sure to include all relevant data from each 
trial, the molarity of NaOH determined from the data from each trial, and the average molarity of 
the NaOH solution.  Provide sample calculations on a separate sheet of paper. 
 
Table 2 – Titration Data (Part II) for Acetic Acid/Ka from Equilibrium Expression 
On a separate sheet of paper, prepare a table which presents your data for the titration of the 
acetic acid solution with your standard sodium hydroxide solution.  Be sure to include the 
average molarity of the acetic acid solution.  Also include the pH of the acetic acid solution 
before you started the titration.  Calculate Ka from the equilibrium expression, equation (2).  
Provide sample calculations on a separate sheet of paper. 
 
Table 3 – Titration Data from Part III (Titration Curves) 
Prepare a table that presents your data for the titration of the acetic acid solution from you 
titration curves.  This should include the equivalent point volume, half-equivalent point volume, 
molarity and average molarity of the acetic acid solution, and the pKa and Ka of acetic acid.  
Provide sample calculations on a separate sheet of paper. 
 
Table 4 – Half-Titration Data from Part IV 
Prepare a brief table that presents the volume of base used to reach the equivalence point, pH at 
equivalence point, the total volume of base used, the actual amount of additional acid used; and 
lastly the pH, and pKa.  Write a statement discussing what you learned from this section. Did the 
Ka value from part 4 match the Ka from part 3? What would happen if you added 25 mL of HCl 
instead of 25 mL of acetic acid to reach the half-way point? 
 
Graphs – Titration Curve 
Use LoggerPro to analyze and print your titration curves.  Use the titration curve to determine 
the equivalence point volume, pKa and Ka for acetic acid; illustrate this on your graph.  Print a 
titration curve graph for each trial performed, if more than one was completed. 
 
Comparison of the acetic acid solution molarities and Ka’s – Brief Discussion 
Compare the Ka values determined by the different methods employed in this experiment.    How 
closely do they agree with each other?  How closely do they agree with the literature value of Ka 
at 25oC?  Also compare the molarities of your acetic acid solution determined by titrating to the 
endpoint in Part II and by developing titration curves in Part III.  How closely do the molarities 
compare?  Discuss possible reasons for discrepancies, and suggest possible improvements to the 
experimental procedure to improve the result 


